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This document is intended to give users in depth description of various aspects of ThunderBench, 
Combined with our video tutorials the user has enough information to start a project, build, 
modify, download to target and debug. ThunderBench is based on the popular Eclipse® IDE /CDT 
platform including the Project explorer, Editor and Views. Many of Eclipse® features are 
highlighted in this document. 
 
 Workspaces & Projects 

 
 

Emprog ThunderBench FOR ARM® 
User’s Guide 

 

 

When you start ThunderBench you 
must select a workspace to be your 
environment space where you can 
create one or multiple projects. 
 
You can change the workspace 
anytime you want, each workspace 
can hold multiple projects.  
 
At startup you can choose the path 
and name of your workspace. 
 
Note: Please do not include spaces 
in the custom name of your 
workspace. 
 
 

Definitions: 

-A workspace holds projects. A workspace is a directory containing project directories.  
-A project contains files. A project is a directory containing files that may contain sub-directories.  
-Each workspace may contain many projects.  
-The user may switch between workspaces, but only one workspace can be active at any one time.  
-Switching workspace will trigger a quick restart of the product.  

Rename a Workspace: 
 
You can’t rename a workspace form inside ThunderBench, you must rename the workspace from 
windows explorer. Each workspace represent a root folder on disk, under this folder you can have 
projects where each project also occupy a separate folder under the workspace. The directory 
structure on disk represents exactly the same structure inside the project explorer in ThunderBench.  
 

 
 
 

ThunderBench Default Workspace Layout 
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 Duplicate a Workspace: 
 
Simply duplicate the directory structure on disk and open the workspace when ThunderBench 
start. At startup ThunderBench lists up to 5 recent workspaces. 
 
If you wish to switch workspace from inside ThunderBench, you can click on File>Switch 
Workspace >Other and choose another workspace. The IDE will restart with the new workspace. 
 
Creating a project is a little bit different. In ThunderBench creation, rename, duplicate and delete  
projects should be done from within ThunderBench. Changes done form from Windows explorer 
are not reflected inside the project explorer. 
 
Create new Project: 
 
To create a new project please follow the instructions using one of our three main wizards, 
described in the Quick Start Guide. 
 
Excerpt: There are three ways to create an ARM ready project: 
 
1- Import a ready-made BSP for a starter kit or a development board (recommended because it is 
the fastest way to start your application. 
 
2- Create a Target Specific project using The ThunderBench wizard, this wizard will give the basic 
structure of an ARM application tailored towards your selected ARM device, with the proper 
startup and systems files or CMSIS basic set of files. 
 
3- For those users who like to start with the core of things, you can create through the bare bone 
core wizard a project an ARM project for your selected ARM device , but this project will only 
contain an empty main(). As is, this project cannot be debugged; the user must include the 
proper startup and system files. 
 
Note: if you did not find the BSP you need or the target you have within our selection please refer 
to our ThunderCloud section. ThunderCloud is always being updated with the latest Targets and 
BSPs. If you still cannot find it, please contact our support team. 
 

You can access all these wizards by opening the Control Center . Once you have a projected 
imported or created, the project is listed as a collapsible tree inside the project explorer.  
 
Rename a project: 
 
Simply highlight the Name of the project in the tree, then right-click and choose rename, or hit 
F2. This will rename the project inside the project explorer and renames the folder in Windows.  
 
Note: Renaming a project from Windows Explorer will not rename it in ThunderBench, please 
avoid project manipulation directly from the file system. 
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   The name of the folder is considered the root level of the project a.k.a the root node. 
Expanding the root node will list the sub-folders and files underneath the project. 
 
Note: the root node is an important level in a particular project and will be mentioned often 
in this guide. 
 
Duplicate a project: 
 
To duplicate a project right- click on the root node of the project, choose COPY (ctrl-c), then 
right-click somewhere inside your project explorer, then choose PASTE (ctrl-v). This will 
duplicate your project and you will also have the chance to rename it. 
 
 
Delete a project: 
 
If you wish to delete your project from your workspace, right-click on the root node of the 
project, then choose Delete. ThunderBench will ask if you want to remove the project from 
the workspace ONLY, or you also want to remove permanently the files and folder on disk 
associated with this project.  Keeping the files and folders on disk will not help bringing back 
the project into the workspace, for this task you need to import the project into the 
workspace. 
 
Import a project: 
 
Considering you have a project already created by ThunderBench, to the extend of being the 
same version of your ThunderBench, you can use the Import function. Go to 
File>Import>General>Existing project into Workspace , pick the location of your project 
directory or if your project was in a .zip file select the archive file to import. Imported project 
can be raw directory with files and folders, or an archive file like .zip. 
 
Note: Imported project usually take the characteristics of the receiving workspace, this is why 
it is recommended to always share project inside their workspace, this way you can easily 
open the workspace and have your project ready. If you want to send/receive a 
ThunderBench project to/ from your client or consultant, the best way is to duplicate the 
workspace where the project exists (if you have multiple projects you can clean them up) and 
send it to the other user. This way the other party will simply load the workspace as is with 
the project properly configured inside it. By doing so you insure a wider collection of 
ThunderBench versions will read and can receive your project.  
 
 
Export or share a project: 
 
As the note above imply, it is recommended to share your project inside its workspace vs 
exporting the project and then importing it. Simply duplicate the workspace where the 
project exists (if you have multiple projects you can clean them up) and send it to the other 
user, or keep it as a backup to yourself. 
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Archive or backup a project: 
 
In embedded development the user always have to archive or backup your project/workspace. It 
is perfectly recommended and safe to duplicate the entire workspace as is and archive it. For later 
use if needed. 
 

 

New Files and Folders 

Add a file, folder and source folder 
to a project: 
 
Right-click on the project root node, 
or the source folder, or sub folder in 
your project, then choose NEW. 
 
In the NEW context menu you can 
add a source file, or a sub folder, or 
a main source folder. 
 
Note: Source folders are only allowed 
at the root node level in your project. 
 

Basic Project Structure: 
 
Once a project is created the 
Project Explorer docking view is 
populated with the chosen project, 
and the project is built 
automatically.  

In the Project Explorer window, 
the subfolders can be expanded.  

Each source files can be expanded 
to list its outline, like header files, 
variables and functions included in 
this source file. Clicking on a 
function will take you directly to 
the function body inside the 
source and the source file is 
opened in the Editor Window. 

Colored decorators are used to 
distinguish between various 
elements inside the source file. 

 

 
Basic Project Structure 
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An ARM® C project typically includes: 

 A binary folder where the .elf file is listed. 

 

 An include folder, listing all the paths that the compiler and linker will search to find header 
files or libraries. 

 

 Startup code to initialize variables, set up stack and heap and place exception handler 
(interrupt) table in default memory location. 

 

 Code to initialize core functions like system clocks, typically called system.c 

 

 An src folder, typically include user source files including a main.c, the start of the user code 
and where main() function is found 

 

 CMSIS functions and header files, if the users is using CMSIS standard core files. 

 

 Optionally, a syscalls.c module for I/O redirection is needed, known also as Stubs. 

 

 A Debug folder where the .elf file is found to be used by the debugger, also the tools will 
generate a .bin file to be used by any flash utility to program your ARM device. 

 

 A debugger launch file, xxx_debugger.launch, this file contains information and proper 
initialization for your JTAG probe and Debugger, double click in this launcher to start a debug 
session. 

 Linker script file (.ld) that reflects the memory map and regions with FLASH and RAM section 
a.k.a as .text and .data sections for the chosen device. This file is typically called startup.s or 
startup.c 
 



           Emprog  

  Page | 7  
 

User’s Guide v1.2 

 

  ThunderBench Perspective 
Workspace & Projects 
 
 

 

ThunderBench Default Layout 

By default ThunderBench layout 
starts with: 
 
1- Project Explorer 
2- The Editor 
3- The console view 
4- The problems or “Errors and 
Warnings” view.  
5- ThunderBench Toolbar 
 
All sections can hold multiple views 
 
All views and windows can be 
detached or docked and the layout 
can be customized. 
 

Any time you can go back to the ThunderBench perspective a.k.a IDE by clicking   . If you 
change the layout or toolbar or anything in the IDE, to go back and reset the Ide perspective, please 
click on Window>Reset Perspective… then restart your ThunderBench. Everything will go back to 
default. 
 
The Project Explorer: 
 
The Project Explorer can hold one or multiple projects, these project can be closed and re-open, 
selecting a project is highlighting any file inside that project, make that project as active. You can 
isolate a single project by right-clicking on the root node (project name) and choosing GO INTO. This 
will isolate a single project in the project explorer view. It is recommended always to isolate the active 
project in its own view. 
 
The Project Explorer also have a context menu (right-click), that will change whether you selected a 
Project or a folder or a source file. It is recommended o always check the context menu to see what 
basic functions can be done on each item inside the project. 
 
For example, right click on the root node of your project, then choose Close Unrelated Projects, this 
will close all other projects and keep your selected project active.  
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The Editor: 
 
The editor window is a fully compliant C/C++ and assembly editor with syntax highlighting. Also the 

editor displays the control center , and all open files whether text based, or hex bases or binary will 
open inside the editor window. 
 
The Editor window can be detached and maximized for better code writing, and still be part of the 
build system and part of the project that can be built into target application.   
 
To detach the editor window, open a file then drag the TAB of the file name outside the ThunderBench 
IDE. You can detach all open source and other types of files. 
 
 

 

ThunderBench Content Assist 

 

Some useful hints for the Editor: 
 
Note: Most C/C++ related Editor Preferences can 
be customized and set by going to:  
Window>preference>C/C++>Editor. 
 
- Content Assist, as shown on the right, type the 
construct of the structure and when you hit “.” 
ThunderBench will suggest a list of the elements 
of that structure. 
 
- Folding, folding of comments and functions. 
 
- When you hover the mouse over a function, 
symbol, macro or structured element, 
ThunderBench will expand the details or the 
preprocessor values in a tooltip. 
 
- Syntax coloring, the user can customize, syntax 
coloring for C/C++ code, assembly, comments, 
preprocess and others … 
 
- Mark Occurrence, when enabled the editor will 
mark all occurrences of the element you highlight 
in the source window, enabling you to track the 
symbol, variables, SFR or others… 
 
- In huge files, scalability option is triggered and 
some editor features are disabled for 
performance. The Default is 5000 lines, but this 
can be modified in Window>Preference>C/C++ 
>Editor>Scalability 
 

 

ThunderBench Syntax Coloring 
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  - Macro/Function Expansion, just hover the 
mouse over the function call and you will get the 
expanded view of that function including all 
parameters and declarations. 
 

 

ThunderBench Macro Expansion 
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ThunderBench Auto-complete templates 

 

- C/C++ Keywords template setup and editor, 
as shown on the right, the user can customize 
the default templates or adds own template.  
 
You can activate the auto complete in your 
source window for the “for loop” by typing for 
then ctrl-space, ThunderBench will suggest to 
build the “for loop” for you according to the 
template you set.  The common C/C++ 
templates are already included but you can 
setup your own or custom at 
Window>Preference>C/C++> Editor> 
Templates 
 
- Typing Closures, like auto close parentheses 
and brackets etc… 
 
- Code style templates, as shown on the right, 
when you open a new C file, the file will be 
automatically populated with desired code. 
 
- Window>Preference>C/C++ lists many 
customization that can help user custom and 
tailor the workspace. 
 
 

 
ThunderBench Code Template 
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ThunderBench Problems & Console View 

 

Problems view: 
 
In the problems view you 
can click on the error or 
warning and it will take you 
to offending line in the 
source, even if the file was 
not open. 
 
Warnings and errors are 
highlighted (yellow and red) 
with more details in the 
console view. 
 

The Console view: 
 
In the console view the user can monitor the activity of the compiler and linker, also warning and 
errors are highlighted with more details. 
 
The console also displays statistics information about the target application like the size of your 
code and data.  It is recommended to keep the console view open at all time, all systems 
messages are display in this view. 
 

 Will clear the content of the console, useful if you wish to track a particular issue. 
 

 Each tool or system running in your ThunderBench will/might output information in a different 
console view. Multiple console views will be stacked and selected by this drop down box. A typical 
example is the default build view and the GDB Server view with information about your connection to 
target. 
 

 This will jump to next or previous error in your source code. 
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  ThunderBench main Toolbar: 

 

-  This will open ThunderCloud where you can download up-to-date example BSP ad target 
specific projects. You can also open ThunderCloud from the Control Center. 
 

-  Saves any open source, or all files open files. Print the active source file.  
Note: ThunderBench will automatically saves all your source file before building the project. 
 

-  This will rebuild your project, cleans object files, re-index then build your project. 
 

-  Will refresh any changes done to your project. Saves all changes to disk and 
refreshes the index. 
 

-  Will open the project properties like Tools Settings, where Target Setup, Compiler, 
Linker and other tools options are listed 
 

-  Will clean the project from old object files and make the project ready to build 
again. 
 

-  Will build project, this will build the modified files, and if you cleaned the project it 
will become like rebuild. Commonly this is the build action icon to use, this will follow 
the dependencies, for example if you have 200 files already compiled and one file giving 
error, you fix the error,  this build icon will only compile the modified file and does not 
re-compile the other 199.  
 

-  Starts the debugger 
 

-  Launch an external command tools. 
 

-  To search for a keyword or phrase within the document. 
 

-  To search for a string in all the files in the project. Click  and select File Search and 
choose to search in all projects in your workspace, or the selected resource (folder or 
project) 
 

- The highlighter tool, when toggled enabled, each variable or symbol you highlight 
or double click on, all occurrence of this variable or SFR will be highlighted in the open 
source file. 
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-  This will manually start the GDB server session for your selected JTAG probe. It is 
useful if you are trying for the first time to simply communicate with the target phase before 
debugging. This will also solve any communication errors between your PC and Target via the 
JTAG probe. Remember the debugger will not connect to any hardware unless the GDB Server 
connects properly.  
 

- Opens the Control Center. 
 

-  Switch back and forth from ThunderBench perspective (IDE) and the 
Debugger Perspective. 
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  ARM® Project Properties & Tools Settings 
Workspace & Projects 
 
 

 

ARM project properties and tools settings 

 

Overview of the project properties: 

Click on the root node of your project then click on  to display the Tools settings and properties. The 
most common and used project properties are: 

- Target Setup. 

- Tools Settings, where you find the General Option for your specific target, compiler, linker and other 
tools options. 

- Build Steps, to control the build process, like whether to stop after first error, to continue build and 
display all errors at once (recommended) 
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  Target Setup: 

As shown to the right, the target setup wizard will help 
you select your chip vendor and specific target, then it 
will setup the basic options needed like proper core 
and proper linker file in the tools settings, information 
taken from ThunderBench target database. 

Note 1: When you import an example BSP or create a 
project using our Project Wizards, normally you don’t 
have to setup your target, ThunderBench already fixed 
these settings for you.  

Note 2: In the even you want to change target, the 
Target Setup will help you re-establish your new device 
and settings and override the previous target settings.  

Note 3: If you wish to change your project Code 
Location only, please pick your Chip Vendor and 
specific target then pick whether FLASH or RAM. 
Please be cautious when choosing RAM, this might not 
be fully supported with your target selection. On the 
other hand, some target have only RAM and changing 
the code location to RAM is required. Please consult 
with our support team on this issue.  

 

 

 

 

 

 

 

Target Setup 

All about Configurations: 

By default ThunderBench creates a Debug and Release configuration, to comply with the original CDT. In 
reality and in embedded programming the user is not bound to use multiple configurations, one for 
debugging and another for release a.k.a production.  

Debug and Release configurations simply represent 2 separate and independent set of options. 

Typically the default Debug configuration is used for both debugging and production environment, 
ThunderBench generates in a single build both a .elf file for debugging and a .bin file to share or to send 
over for testing or production, so no need for a separate configuration. 

It is highly recommended to stick to one configuration, simpler and better managed. It is easy to loose 
track of which configuration is the active one. 
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Project & Tools Settings: 

Target Processor: 

Core Processor: This is the core of your target, 
please pick one of the listed core. If you used any 
ThunderBench project wizards, this options is 
automatically set for you following the target 
information database 

Thumb: Please click if you want to generate thumb 
instruction (default for all cortex targets), if 
unclicked the compiler will generate full ARM 
instructions. 

Thumb Interwork: Generate code that supports 
calling between the ARM and Thumb instruction 
sets. Without this option, on pre-v5 architectures, 
the two instruction sets cannot be reliably used 
inside one program. The default is -mno-thumb-
interwork, since slightly larger code is generated 
when -mthumb-interwork is specified. In AAPCS 
configurations this option is meaningless. 

Endiannes: Specify whether Little or Big Endian, 
default is Little Endian that covers most ARM 
targets and it is the default for all Cortex Cores. 

Float ABI: Specifies which floating-point ABI to 
use. Permissible values are: ‘Software float 
library’, ‘Mixed SW/HW library with FPU’ and ‘FPU 
hardware instructions’. Specifying ‘soft’ causes the 
compiler to generate output containing library 
calls for floating-point operations. ‘Software float 
library’ allows the generation of code using 
hardware floating-point instructions, but still uses 
the soft-float calling conventions. ‘FPU hardware 
instructions‘ allows generation of floating-point 
instructions and uses FPU-specific calling 
conventions. The default depends on the specific 
target configuration. Note that the hard-float and 
soft-float ABIs are not link-compatible; you must 
compile your entire program with the same ABI, 
and link with a compatible set of libraries. The 
default is ‘Software float library’ and that covers 
all ARM targets. To use hard you must have an 
FPU inside your target. 
 
 

 

 

 

 

Target Processor Options 
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  FPU Type: This specifies what floating-point 
hardware (or hardware emulation) is available on 
the target. Permissible names are: ‘vfp’, ‘vfpv3’, 
‘vfpv3-fp16’, ‘vfpv3-d16 (Cortex-A/R)’, ‘vfpv3-d16-
fp16’, ‘vfpv3xd’, ‘vfpv3xd-fp16’, ‘neon’, ‘neon-
fp16’, ‘vfpv4’, ‘vfpv4-d16’, ‘fpv4-sp-d16 (Cortex-
M4)’, ‘neon-vfpv4’, ‘fp-armv8’, ‘neon-fp-armv8’, 
and ‘crypto-neon-fp-armv8’. If -msoft-float is 
specified this specifies the format of floating-point 
values.If the selected floating-point hardware 
includes the NEON extension (e.g. -mfpu=‘neon’), 
note that floating-point operations are not 
generated by GCC's auto-vectorization pass unless 
-funsafe-math-optimizations is also specified. This 
is because NEON hardware does not fully 
implement the IEEE 754 standard for floating-
point arithmetic (in particular denormal values are 
treated as zero), so the use of NEON instructions 
may lead to a loss of precision. 
 
Debugging: 
 
Debug Level: Default is g3 for maximum 
debugging visibility. 

 
Debug Format: Default is dwarf-2 compatible with 
the debugger. 

Stack Usage Report: When enabled the tools will 
generate a StackUsageReport.html file in your 
project, containing the stack usage of all used and 
linked functions in your application. In the Report 
the Type static means that the function 
manipulates the stack statically: a fixed number 
 
 

 

 

 

 

 

of bytes are allocated for the frame on function entry and released on function exit; no stack 
adjustments are otherwise made in the function. The Type dynamic means that the function 
manipulates the stack dynamically: in addition to the static allocation described above, stack 
adjustments are made in the body of the function, for example to push/pop arguments around 
function calls. If the Type is bounded, the amount of these adjustments is bounded at compile 
time.  

Other debugging flags: extra command line option you might pass to the debugger. Not 
commonly used. 
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Additional Tools: 
 
Create Flash Image (.bin): Create a secondary 
output file by default ThunderBench create the .elf 
file for debugging with C and Assembly source and 
a secondary pure binary output file .bin to use 
with any flash programming to program your 
device (without debugging) or for production 
purpose, or for sharing your application with 
others without sharing the source. 

Create Extended Listing: Creates a .eLST file in the 
Debug/Release output folder, containing a cross 
reference of C and Assembly of your entire 
application. All addresses are resolved. It is a full 
image of your application, as resolved by the 
linker. 

 Output Project Size Flash and Data: At the end of 
the build the tools will output in the console view 
the Flash (code) size in bytes, and the data (RAM) 
size allocated plus the total Flash +RAM. 
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Thunder ARM Compiler: 

Summary Page:  

This page is for information only, it states the path 
of the active compiler, and a collection of all 
options used and passed to the compiler, and the 
command line pattern. Not commonly used or 
modified. Please use defaults. 

 

 

Preprocessor: 
 
Do not search system directories: Do not search 
the standard system directories for header files. 
Only the directories you have specified with '-I' 
options (and the directory of the current file, if 
appropriate) are searched 
 

Preprocessor only: Stop after the preprocessing 
stage; do not run the compiler. The output is in 
the form of preprocessed source code, which is 
sent to the standard output. Input files which 
don't require preprocessing are ignored. 
 

Defined Symbols: Define Symbols that are used 
inside the code with ifdef directives to control the 
compilation of the code. Example: 
My_Symbol=1 or My_Symbol. Both formats define 
My_Symbol as true or 1. 
 

Undefine Symbols: It will undefine symbols 
previously Defined. This is used if you want to 
temporary undefine a symbol without removing it 
from the list. 
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Directories:  

Include Paths: Add the directory to the list of 
directories to be searched for header files. 
Directories named by '-I' are searched before the 
standard system include directories. If the directory 
is a standard system include directory, the option is 
ignored to ensure that the default search order for 
system directories and the special treatment of 
system headers are not defeated. You can pick 
folders from the workspace or from the file system. 
Commonly you include folders from your project 
where you want the compiler to search for the 
included header files. 

 

 

Optimization: 
 
Optimization level: 
 
-O0 (NONE) Do not optimize. This is the default. 

 -Os Optimize for size. '-Os' enables all '-O2' 
optimizations that do not typically increase code 
size. It also performs further optimizations designed 
to reduce code size. '-Os' disables the following 
optimization flags: -falign-functions -falign-jumps -
falign-loops -falign-labels -freorder-blocks -
fprefetch-loop-arrays (Commonly used) 
 

-O1  With '-O1', the compiler tries to reduce code 
size and execution time, without performing any 
optimizations that take a great deal of compilation 
time. It turns on the following optimization flags: -
fdefer-pop -fmerge-constants -fthread-jumps -
floop-optimize -fcrossjumping -fif-conversion -fif-
conversion2 -fdelayed-branch -fguess-branch-
probability -fcprop-registers it also turns on '-fomit-
frame-pointer' on machines where doing so does 
not interfere with debugging. 
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-O2  Optimize even more. The compiler performs nearly all supported optimizations that do 
not involve a space-speed tradeoff. The compiler does not perform loop unrolling or 
function inlining when you specify '-O2'. As compared to '-O1', this option increases both 
compilation time and the performance of the generated code. '-O2' turns on all 
optimization flags specified by '-O1'. It also turns on the following optimization flags: -
fforce-mem -foptimize-sibling-calls -fstrength-reduce -fcse-follow-jumps -fcse-skip-blocks -
frerun-cse-after-loop -frerun-loop-opt -fgcse -fgcse-lm -fgcse-sm -fdelete-null-pointer-
checks -fexpensive-optimizations -fregmove -fschedule-insns -fschedule-insns2 -fsched-
interblock -fsched-spec -fcaller-saves -fpeephole2 -freorder-blocks -freorder-functions -
fstrict-aliasing -falign-functions -falign-jumps -falign-loops -falign-labels Please note the 
warning under '-fgcse' about invoking '-O2' on programs that use computed gotos. 
 
-O3 Optimize yet more. '-O3' turns on all optimizations specified by '-O2' and also turns on 
the '-finline-functions' and '-frename-registers' options. 
 
Pack structure: Pack all structure members together without holes. Please use with care 
and test your application. 
 
Short enumarations: Allocate to an enum type only as many bytes as it needs for the 
declared range of possible values. Specifically, the enum type will be equivalent to the 
smallest integer type which has enough room. Please use with care and test your 
application. 
 
Function sections/Data Sections: Place each function or data item into its own section in 
the output file if the target supports arbitrary sections. The name of the function or the 
name of the data item determines the section's name in the output file. Use these options 
on systems where the linker can perform optimizations to improve locality of reference in 
the instruction space. Generally reduces the linked application size. Commonly used. 
 
Other optimization flags: For new Optimization -f (flags) introduced, the user can add 
these flags in here to pass them to the compiler. 
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  Warnings: 
 
Check Syntax only: Warning on syntax only 

No Common: Allocate even uninitialized global 
variables in the data section of the object file, 
rather than generating them as common 
blocks. This has the effect that if the same 
variable is declared (without extern) in two 
different compilations, you will get an error 
when you link them. 

Pedantic: Issue all the warnings demanded by 
strict ISO C; reject all programs that use 
forbidden extensions, and some other 
programs that do not follow ISO C. This option 
follows the version of the ISO C standard 
specified by any '-std' option used. 

Pedantic warnings as errors: Like '-pedantic', 
except that errors are produced rather than 
warnings. 

Inhibit all warnings: Disable all warnings (not 
recommended) 

All Warnings: Enable all warnings. 

Extra warnings: Reserved for future version. 

Warnings as errors: Treat all warnings as error. 

Note: If you want to use a specific warning, you 
must unclick the "All Warnings" flag. 

 
Miscellaneous: 

Language Standard : Commonly used are the C90 with GNU extension or the C99 with the GNU 
extension. 

Assembler listing: Specify the file name of the .lst file generated for each source file 

Do not inline functions: Forbid the compiler from inlining function and generate calls to every 
function even if it is repeated. 

Char is signed: treat char type always as signed char (not recommended slower code) 

Bitfields are unsigned: Treat bitfields as unsigned. 

Verbose: Print (on standard error output) the commands executed to run the stages of 
compilation. Also print the version number of the compiler. 

 

Warn if any function stack estimated usage 
exceeds (in bytes): Warn if the stack usage of a 
function might be larger than Number of bytes. 
The computation done to determine the stack 
usage is conservative. Any space allocated via 
alloca, variable-length arrays, or related 
constructs is included by the compiler when 
determining whether or not to issue a warning. 
The message is in keeping with the output of ‘-
fstack-usage’.  If the stack usage is fully static 
but exceeds the specified amount, the warning 
is: “warning: stack usage is 1120 bytes” 
If the stack usage is (partly) dynamic but 
bounded, it will be: “warning: stack usage 
might be 1648 bytes” 
If the stack usage is (partly) dynamic and not 
bounded, it’s: “warning: stack usage might be 
unbounded” 
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  Thunder ARM C linker: 
 
General: 

Do not use standard start files: Do not use the 
standard system startup files when linking. The 
standard system libraries are used normally, 
unless -nostdlib or -nodefaultlibs is used. 

Do not use default libraries: Do not use the 
standard system libraries when linking. Only 
the libraries you specify will be passed to the 
linker. The standard startup files are used 
normally, unless -nostartfiles is used. The 
compiler may generate calls to memcmp, 
memset, memcpy and memmove. These 
entries are usually resolved by entries in libc. 
These entry points should be supplied through 
some other mechanism when this option is 
specified. 

No startup or default libs: Only search library 
directories explicitly specified on the command 
line. Library directories specified in linker 
scripts (including linker scripts specified on the 
command line) are ignored. 

Remove unused sections: Discard unused 
sections, generally produced less code. 

Print removed section: output to standard 
console the section the linker has removed or 
unused for reference. 

Omit all symbols information: Do not include 
symbol information for the debugger. 

Do not use shared libraries: Use static libraries.   

Script file: This is one of the most important 
option in the ARM linker, the scrip file is where 
you declare your memory regions and Flash 
and RAM sections. Please check linker script file 
reference. Normally if you use a ThunderBench 
wizard to create or import a project, this is 
automatically set by the wizard. 
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Libraries: 

Use Nano libraries: this will instruct the linker 
to link smaller footprint C runtime library (a 
smaller version of libc.a). In general this 
produces less code size, it will link smaller 
(limited in floating point support) printf() or 
sprintf() 

Libraries: Link additional libraries, other than 
the standard libraries. Additional libraries could 
be user libraries or supportive libraries like 
libm.a  (the math library). You don’t have to 
add "lib" or ".a" , by simply put in "m" the 
linker will understand to link libm.a . 

Library search path: Add the Paths for linker to 
look for the libraries listed in Libraries option. 

Miscellaneous: 
 
Linker flags: You can pass to the linker extra 
flags or new flags not listed in the current 
release. 

Map file name: To setup the file name of the 
.map file generated by the linker where you 
can find information about all functions and 
symbols allocation and sizes. 

Cross reference: Generate a cross reference 
symbols for the debugger, cross reference 
every .C function with its corresponding 
assembly generated by the compiler. 

Print link map: output the .map file to the 
console (not recommended). 

Verbose: Print (on standard error output) the 
commands executed to run the stages of 
linking. Also print the version number of the 
linker. 

Other flags: You can pass to the linker extra 
flags or new flags not listed in the current 
release 
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Thunder ARM Assembler 

Preprocessor: 

Use Preprocessor: Generate preprocessor 
information. 

Do not search system directories: When clicked 
the assembler will not search any system libraries, 
default not clicked. 

Preprocessor only: Run preprocessor information 
only do not assemble into object. 

Defined Symbols: This is where you define 
symbols to pass and control the assembler. 

UnDefined Symbols: If you already have a symbol 
defined in your source code and you want to 
temporary un-define it. 

 

 

Directories: 

Add all search paths directories that the assembler 
will use to search for header files and symbols. 

 

 

 

Warnings: 

A set of warnings to set or unset, the default is 
display All warnings (recommended) 

 

 

Miscellaneous: 

Extra assembly options and flags that the user 
might pass on to the assembler.  
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THE END 
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